
l

SLIDERS

   USER’S MANUAL

Updated 9/99



Table of Contents

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Document Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Sliders Basics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
The “Smear Slides” Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
The “Smear Slides” Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Toolbar buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Menu Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

The “Select Slides” Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
The “Component Select” Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Sliders Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Where to Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Data can be entered in several different ways  . . . . . . . . . . . . . . . . . . . . . . . . . 11
Notice the changes that have occurred . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Several important features of this screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Sliders In Depth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Exporting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Importing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Editing Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Adding a New Component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Editing a Component  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Setting up Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17



Table of Figures

Figure 1.    The “Smear Slides” window.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Figure 2.    The “Select Slides” window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Figure 3.    The “Component Select” window.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Figure 4.    Select sample information from this window. . . . . . . . . . . . . . . . . . . . . 8
Figure 5.    Selected slide information.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Figure 6.    Add a new slide here.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Figure 7.    Slides selected for data analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Figure 8.    Samples ready for analysis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Figure 9.    Selected components for the spreadsheet. . . . . . . . . . . . . . . . . . . . . . . . 10
Figure 10.  Spreadsheet with selected slides, components, and data.  . . . . . . . . . . . 10
Figure 11.  Enter file name of data to be exported here.  . . . . . . . . . . . . . . . . . . . . . 12
Figure 12.  Open your Excel spreadsheet from this window.  . . . . . . . . . . . . . . . . . 13
Figure 13.  Import to Sliders from this window. . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Figure 14.  List of component types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Figure 15.  Edit or add a component here. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16



Sliders User’s Manual 1

h use 

s’ 
Introduction
Sliders is a program designed to aid in the recording of smear slide data. The data entered for 
each slide is saved to the central database. The main working window is a spreadsheet similar 
in look and function to Excel. Shipboard use will generally be in the hard rock café. Beac
will most often be in the repositories.

Document Layout
The Sliders document is broken into three main sections. The first section, “Sliders Basics”, 
describes starting the program and each of the main windows. The second section, “Sliders 
Examples”, goes through an example of smear slide analysis from beginning to end. The third 
section, “Sliders In Depth”, gives a detailed description of several of the additional Slider
functions.
Ocean Drilling Program
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Sliders Basics
Getting Started

1. Click on the Sliders icon to start the program.

2.  A “Login” window appears asking for a User Name, Password, and Host String. E
these fields the very first time the program is started. 

Note: Sliders automatically remembers the User Name and 
Host String after the first time the program is opened.

3. Check the “Remember Password” box if you want the program to default to your 
word each time, then click OK.

The “Smear Slides” Window
The “Smear Slides” window automatically opens when Sliders is started (See Figure 1)

Figure 1. The “Smear Slides” window.

1. Smear slide sample information (leg, site, H, core, sct, top, and depth) is imported to 
Ocean Drilling Program
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this window from the “Select Slides” window (More in "The “Select Slides” Win-
dow", p. 5).

2. Components are imported to this window from the “Component Select” window 
(More in "The “Component Select” Window", p. 6).

3. All smear slide component data and comments are entered on this window.

The “Smear Slides” Toolbar
Toolbar buttons

• Click New or F5 for a new “Smear Slides” spreadsheet.

• Click Save or F6 to save information to the database.

• Click Slides or F7 to open the “Select Slides” window.

• Click Components or F8 to open the “Component Select” window.

Menu Options

1. Under “Slides”

• New Spreadsheet – opens a clear spreadsheet.

• Save Data - saves data to the central database.

• Export – opens a window for exporting data to Excel as a Comma Delimited File 
(More in “Exporting”, Section 3).

• Import – opens a window for importing Comma Delimited files from Excel into
the Sliders program (more in “Importing”,  Section 3).

• Edit Components – opens the “Component List” window. Add, delete, or edit 
slide components from this window (More in "Editing Components", p. 16).

• Exit – closes the Sliders program.

2. Under “Lists”

• Select Slides – opens the “Select Slides” window. Same function as the Slides but-
ton or F7 key (More in "The “Select Slides” Window", p. 5).

• Select Components – opens the “Component Select” window. Same function a
the Components button or F8 key (More in "The “Component Select” Window",
p. 6).

3. Under “Reports”

• Slides – opens a report form (e.g. Smear Slides Form). For more information,
“Predefined Queries” in Janusweb. Also, More in "Setting up Reports", p. 17.
Ocean Drilling Program
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• Components – this selection not developed yet.

4. Under “Options”

• Setup Report –opens a “Setup Reports” screen (More in "Setting up Reports"
17).

• Change Header Font – this selection reduces or increases the spreadsheet fo
size.

5. Under “Help”

• Index – this option not developed yet.

• About Sliders – details the Sliders’ copyright information.
Ocean Drilling Program



Sliders User’s Manual 5

mear 
The “Select Slides” Window
Select all smear slides for analysis at this window. Open this window by clicking on the Slides 
button, the F7 key, or by selecting it from the Lists menu.

Figure 2. The “Select Slides” window.

1. Select a leg, hole, core and section from top left columns. Use the scroll bars to view 
all possible selections. The Site selections displayed correspond to the Leg # selected, 
as the Hole selections displayed then corresond to the Site selected, etc.

Note: Hole, Core, and Section default to “all” when no selec-
tion is made.

2. Slides corresponding to the selected information appear in the “Slides” box.

Note: Top distance and Depth are added automatically.

3. To add a new slide that’s not currently displayed, enter the “top” distance of the s
slide and click on the Add New Slide button.

4. Select a slide for analysis by highlighting it then clicking on Add. Select all slides dis-
Ocean Drilling Program
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played by clicking on Add All.

5. All slides chosen for analysis are displayed in the “Selected Slides” spreadsheet.

6. Remove a selected slide at any time by highlighting it and clicking Remove for one 
slide, or Remove All to de-select all slides displayed.

7. Clicking OK then exports all selected samples to the main spreadsheet.

8. Click on Cancel to close the window without saving any of the selections.

The “Component Select” Window
Select components for the “Smear Slides” spreadsheet from this window. Open it by clic
on the Components button, the F8 key, or by selecting it from the Lists menu.

Figure 3. The “Component Select” window.

1. Select the material type by clicking on the top left down arrow to display the drop-
down list of choices (Mineral, Rock, Biogenic, and Other). Click on your selection.

2. Next, select the components. Once a material type is selected, corresponding compo-
nents are listed beneath the type. Highlight your choice and click on the Add button. 
Ocean Drilling Program
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Note: Continue doing this until you have selected all the 
components you need for your spreadsheet.

3. View your component selections in the right side box.

4. Remove a selected component at any time by highlighting it and clicking on the 
Remove button.

5. Export the components to the spreadsheet by clicking on the OK button. The selected 
components will become columns on the spreadsheet.

6. Click Cancel to close the window without saving any of the selections.
Ocean Drilling Program
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Sliders Examples
This section takes you through an entry and analysis example from beginning to end.

Where to Start
The “Smear Slides” window automatically opens when Sliders is started.

1. Press the Slides button or the F7 key to open the “Select Slides” screen.

2. Select the leg, site, hole, core, and section information for the slides you want to ana
lyze (Figure 4 shows that leg 172, site 1064, hole A, core 3H, section 7 have bee
selected).

Figure 4. Select sample information from this window.

3. Slides corresponding to the selected information should now be listed in the “Slid
box (See Figure 5). Notice that Top distance and Depths have been added.

Figure 5. Selected slide information.

4. Add a slide that is not displayed by entering its top distance and pressing the Add New 
Slide button (See Figure 6).

Figure 6. Add a new slide here.

5. Highlight the slides you want to analyze and press the Add button.
Ocean Drilling Program
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6. Observe that the slides you selected are now under the “Selected Slides” box (se
ure 7).

Figure 7. Slides selected for data analysis

7. Press OK and this information will export to the sample side of the “Smear Slides
spreadsheet (In Figure 8, notice that the two lines of data from Figure 7 are now 
sample section). 

Note: The spreadsheet automatically opens. The slides are 
now ready for analysis. 

Figure 8. Samples ready for analysis.

8. Press the Components button to open the “Components Select” window. 

• Select the component you want by highlighting first and then pressing Add.

• Press OK once you’ve selected all the components you want (See Figure 9).
Ocean Drilling Program
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Figure 9. Selected components for the spreadsheet.

9. The spreadsheet reappears with the newly added components (See Figure 10).

Figure 10. Spreadsheet with selected slides, components, and data.
Ocean Drilling Program
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Data can be entered in several different ways

1. Click on a cell to highlight it or use the arrow keys to move around.

2. Type in a value. Notice it appears in the cell and the entry prompt. Click Enter or the 
check mark to enter a value. Click Delete or “X” to delete an entered value.

OR

3. Highlight the cell and click the right mouse button. A list of selections is opened f
the highlighted cell. Click on one of the choices.

      OR

4.  Highlight a cell and click on the List button (top right). A list of choices appears for
the highlighted cell. Click on one of the choices.

Notice the changes that have occurred

1. The newly added data is underlined in red. This indicates that the added data is n
saved to the database. Press Save to save new data to the database. 

2. The values under “Text. Total” and “Comps. Total” have changed. The program 
keeps track of the values entered for each component or texture. When the total 
reaches 100 (100%) the number turns from red to black.

Several important features of this screen

1. Pressing the Exit button completely closes the program. Any data underlined in 
red will not be saved when program exits. Be sure to press Save before exiting.

2. Pressing the New button opens a new screen. Any data underlined in red will be 
deleted by pressing New. Always click Save before selecting a new screen.

3. Removing a component from the spreadsheet will remove it from all the sample 
slides shown. (For example, your first two slides might contain component “A”. Th
next four do not. After entering the data for component “A” in the first two slides, y
decide to delete “A” since you don’t need it anymore. This will actually remove “A
and the data entered from the first two slides).

4. To remove slides from the “Smear Slides” window, you must delete them from the
“Select Slides” window.

• First Save all data to the database. 

• Next, click the Slides button, which takes you to the “Select Slides” window. 

• Highlight the slides in the “Selected Slides” box that you want to remove and c
on the Remove button.

• Click OK and the spreadsheet will reappear. The removed slides are no longer on 
the screen, but are still in the database.

5.  A value must be entered for “lithology” or the program will not save.
Ocean Drilling Program
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Sliders In Depth
This section describes additional Sliders’ features.

Exporting
Once you enter smear slide data into the database, you can also export it to another pro
such as Excel, for your own spreadsheet. This is done from the “Smear Slides” spreads

1. From the Slides menu select Export. This opens the “Export to…” window (See Fig
ure 11).

2. Enter a file name. The file should be saved as a Comma Delimited File, so after 
name type  ‘.csv’ (In Figure 11 the filename is “mydata.csv”) Under “Save file as 
type:” select Comma Delimite File (*.csv).

3. Select a Folder to save the data to (Usually C:\ODP\Sliders) and click OK.

Figure 11. Enter file name of data to be exported here.

4. Open Excel.

5. From the File menu select Open. The “Open” window appears.

• Under Files of type: select “Text Files.”

• Under Look in: select the folder you saved the data to (In Figure 12 it is under 
C:\ODP\Sliders).

• Highlight the file and click Open. This opens an Excel spreadsheet with your data.
Ocean Drilling Program
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Figure 12. Open your Excel spreadsheet from this window.

6. To reformat your data to look similar to the Sliders’ spreadsheet:

• From the File menu select Open again.

• Under Files of type: select “Microsoft Excel Files.” The Sliders icon appears in
the window.

• Click Open.

7. A window about Macros will appear. Click Enable Macros.

8. From the Window menu click on the bottom choice, which is the name of your file.
Ocean Drilling Program
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9. From the Tools menu select Macro, then Macros.

10. You are now at the “Macro” window. Press Run. 

11. Your data is now in a format comparable to the “Sliders” program. Save this.

Importing
If you make changes to data while in Excel or another program, the changes should als
saved to the central database. Do this by importing your altered data back into the “Slid
program.

1. Save your data in Excel as a .csv file (Comma Delimited File).

2. Close your file in Excel (Sliders will not import while your Excel file is open).

3. Open Sliders. It will open to the “Smear Slides” window.

4. From the Slides menu select import.

5. The “Import from…” window will open (see Figure 13). Select the file you want to
import and click OK.
Ocean Drilling Program
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Figure 13.  Import to Sliders from this window.

6. If the program detects no problems with the imported data, the “Smear Slides” 
spreadsheet opens with the changes underlined in red. Save this to the central da

7. If the Sliders program does detect a discrepancy, one of two screens (or both) will 
be displayed:

• The “Find Sample” window: This window appears only if (a) more than one 
match or (b) no match is found for the imported slide. 

(1) The top line displays the “Sample from Imported File”.

(2) The bottom line displays the “Matches Found in Database”. 

(3) If no match is found and you want to add this slide to the database, cli
Add New, then OK. If you want to search for it again press Find Again. 

(4) If more than one match is found, highlight one of the “Matches Found 
Database” and click OK. If you decide the slide is not the correct match 
when the spreadsheet appears, select import again and highlight the correct
choice.

• The “Find Component/Type” window: 

(1) The top line displays the Component or Type imported from Excel.

(2) If you added a component or type that is foreign or misspelled, the program 
will find and display the closest match (bottom of window). 

(3) Click either Find Again or OK .

4. Now the spreadsheet opens, with the added changes underlined in red. Press Save to 
save these changes to the database.
Ocean Drilling Program
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Editing Components
It is possible that you’ll want to add, change, or delete components in the database. Just 
remember that any changes made here are also made in the “Component Select” win-
dow (the master list used to select components for the “Smear Slides” spreadsheet).

1. From the Slides menu select Edit Components to open the “Component List” win-
dow.

2. From the top list select a component type–mineral, rock, biogenic, or other (see F
14). A list of corresponding components appears under it.

Figure 14. List of component types

Adding a New Component

1. Add a new component by clicking Add. The “Component Info” window appears 
(See Figure 15). Type in the “Component name” and press OK. Be sure to capitalize 
the first letter of the name.

Figure 15. Edit or add a component here.

Editing a Component

1. Edit a component by highlighting it and clicking on Edit. The “Component Info” 
window appears (See Figure 15). Type the changes and click OK. Be sure to capitalize 
the first letter of the name.

2. Delete a component by highlighting it and pressing Delete. Just remember that this 
deletes the component from the master list.

3. From the “Smear Slides” window press the Components button. Observe the change
you’ve made in the “Component Select” window.
Ocean Drilling Program
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Setting up Reports
ODP data query report forms can be accessed from the “Smear Slides” window.

1. From the Options menu select Setup Reports to open the “Setup Reports” window.

2. The “Path for Web Browser”  URL should already be set to open directly to the O
data request query forms. If the URL does not work, click on the List button for a list 
of options. If you do not know the correct browser, ask an MCS. 

3. The URL for “Slides Report” and “Components Report” should also already be s

4. Click OK. This should start Netscape and open to the selected report form.
Ocean Drilling Program
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